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Welcome to OpenHMI™
Welcome to the quickest and easiest way to create human-machine interface
(HMI) applications for the Microsoft Windows  operating systems. Using
OpenHMI , the application developer can create powerful, full-featured
applications that exploit the key features of Microsoft Windows, including
Dynamic Data Exchange (DDE), Object Linking and Embedding (OLE),
graphics, and more. OpenHMI  can also be extended by adding custom
wizards, generic objects, and script extensions.

The OpenHMI ™ application software consists of two parts: the development
system (software running on a desktop, laptop, or industrial PC) and the
runtime workstation (an OpenHMI operator interface workstation). You
install the OpenHMI software on the PC you would like to use for a
development system. The runtime software is preloaded on the OpenHMI
workstation. On the development PC you can use the OpenHMI  software’s
WindowMaker  to create animated operator interface display windows.

These operator interface display windows can connect to industrial I/O systems
and other Windows applications in the OpenHMI runtime environment—an
OpenHMI workstation  with the WindowViewer runtime software. After you
complete an HMI application in WindowMaker , you download the displays to
the OpenHMI  runtime workstation and run them with the OpenHMI
software’s WindowViewer. The OpenHMI  workstation processes scanned
data from the connected devices according to parameters defined in your
application and displays the data in the graphic display windows.

Note: OpenHMI is a modified version of the popular commercial HMI
software package, InTouch® by Wonderware® corporation. For this reason
you will see references to InTouch on the software’s dialogs and editors.
For the purposes of developing your application with OpenHMI software
supplied by Xycom Automation, you may consider references to InTouch
and OpenHMI as references to the same software product.

Note: Applications built with OpenHMI  software can only run on a Xycom
Automation OpenHMI  workstation.

Note: After you install the development software, you can access more
comprehensive documentation on the OpenHMI WindowMaker by
accessing the PDF documentation through the shortcut on your
development PCs desktop.
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System Requirements
To develop an OpenHMI application with the OpenHMI software, we
recommend the following:

• Any IBM compatible machine with an 5x86 processor or higher

• At least 100MB of free hard disk space

• At least 16MB of random-access memory (RAM)

• SVGA display adapter

• Parallel printer port

• Pointing device (e.g., mouse, trackball, joystick)

• Windows 95 or Windows NT operating systems

To run a developed application, you must have an OpenHMI workstation
with a runtime license.
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Configuration Package Contents
In addition to this Getting Started guide, your configuration package should
contain the following items:

•  OpenHMI Software (on two CDs labeled, “OpenHMI, Productivity
Pack” and “I/O Servers”)

•  Configurator License (on floppy diskette labeled, “consign 1000
tag/100 window”)

•  Universal serial file transfer cable

•  Registration card

•  Read Me First sheet
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Installing the OpenHMI Software
OpenHMI  software runs on Microsoft Windows 95 or Windows NT
operating systems. The installation program creates directories as needed,
copies files to your hard drive, and creates the OpenHMI  icons in a
desktop folder.

 To install OpenHMI on a Windows 95 or Windows NT operating system:

Note: If your laptop or PC does not have a CD-ROM drive available, make
sure that you have a portable CD-ROM drive (and appropriate device
drivers installed) attached to the printer port and powered on.

1. Power up your development PC with Windows NT or 95.

2. Insert OpenHMI CD#1 into your CD-ROM drive.

3. Click the Start button on the Taskbar, then click Run:

 

4. The Run dialog box appears:

 

5. Type “ x:\openhmi setup”  (x your CD-ROM drive) in the Open text
box. You must type the quotes, or the installation program will not start.

6. Click OK . Factory Suite 2000 will start to load. A percentage bar will
display the installation’s progress.
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7. When the “Welcome to the system files setup program.” screen
appears, click Next, then Next, again, at the second welcome screen.

Note: The installation program will update existing registry entries (for
TCP/IP, user registration, DLLs, etc.). Depending on the existing
entries on your development system, these registry updates may cause
the Windows operating system to restart the workstation before the
installation is complete. If you have not selected components (step 15)
before you are asked to restart the operating system, you will have to
follow the installation procedure, again, from the beginning.

8. When the license information screen appears, click Yes, if you agree with
the terms of the license. You must select “Yes” to complete the setup.

9. Enter your name and company to complete the user information screen
and click Next.

10. Click OK  to verify the name and company.

11. When prompted to specify a directory for common components, click
Next to accept the default. The installation program will display a
progress bar as it loads some common program components.

12. If you get a “Version Conflict” message, click Yes to keep the
existing file.

13. When prompted to specify an Intouch Destination directory, click Next
to keep the default.

14. If you don’t already have the Acrobat Reader installed on your system,
a sequence will begin to install the Acrobat Reader onto your system.
This reader allows you to view the online documentation that the install
program saves to hard disk in PDF format. Click Next through each
step of this sequence, then OK  when the sequence is complete.

15. Select components when prompted. Xycom Automation recommends:
Intouch
Demos that match your OpenHMI workstation’s resolution (640 x 480
or 800 x 600)
Intouch 7.0 Recipe Manager
Online Manuals
When you finish selecting components, Click Next.

Note: The SPC and SQL components are not supported by the
OpenHMI runtime workstations.

16. When the configuration options screen appears, verify that
Development System and Help Files are checked and that Factory
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Focus and Runtime are not checked, then click Next. The installation
program will copy the remaining files to the hard drive.

17. A screen will display the components that you have selected to install.
Click Next to continue. The installation program will display a progress
bar as it completes installation.

18. When installation is complete, you may select OK  to review the release
notes.

19. Before you can start the development software, you must click OK
when prompted to restart the computer, so that the required settings
may take effect.

Note: Setup can be run as many times as necessary to install optional
program modules or I/O Servers.
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Installing an I/O Server
The WindowViewer software, preloaded on your OpenHMI runtime
workstation, acquires the data values from PLCs and other devices through
I/O Servers that support the Windows DDE protocol. You must install an
I/O server that corresponds to your I/O device onto your development
system. Through I/O server configuration, you will specify the parameters
that are required for communication between your I/O and workstation.

Note: This procedure is given for your information when developing a real-
world application. The demo application covered by this Getting Started
Guide uses a simulated server that is automatically installed with the
development software.

Version 7.0 Servers
Follow these steps to install a version 7.0 I/O server.

1. Insert OpenHMI CD#2 into your CD-ROM drive.

2. Click the Start button on the Taskbar, then click Run:

 

3. The Run dialog box appears:

 

4. Type “ x:\io server setup” (x is your CD-ROM drive) in the Open text
box. You must type the quotes, or the installation program will not start.

5. Click OK . Factory Suite 2000 will start to load. A percentage bar will
display the installation’s progress.
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6. When prompted with a list of I/O servers, select a server and click Next.

Note: The versions of the servers are indicated on the server list. If you
select a server that is below version 7.0, then the rest of the installation
process will differ slightly from the installation of version 7.0 drivers. You
may refer to the next section to complete installation of an older driver.

7. When prompted to verify setup information, click Next.

8. When prompted to review the I/O server release notes, in the next
installation dialog, you may select Yes or No.

9. Click Yes to continue the installation.

10. When the “Welcome to the system files setup program.” screen
appears, click Next, then Next, again, at the second welcome screen.

11. When the license information screen appears, click Yes, if you agree with
the terms of the license. You must select “Yes” to complete the setup.

12. Verify the name and company in the user information screen and
click Next.

13. Click Yes to confirm registration.

14. When prompted to specify an Intouch Destination directory, click Next
to keep the default. The I/O Server setup program will install the
common components.

15. If you don’t already have the Acrobat Reader installed on your system,
a sequence will begin to install the Acrobat Reader onto your system.
This reader allows you to view the online documentation that the install
program saves to hard disk in PDF format. Click Next through each
step of this sequence, then OK  when the sequence is complete.

16. When prompted again to specify an Intouch Destination directory, click
Next to keep the default.

17. You will be prompted to select the components to install. Click Next to
accept the default of all components.

18. Click Next to verify setup information and complete I/O Server
installation. The I/O Server setup program will install files for your
specific server.

20. At the final prompt select Yes (then Finish) if you do not need to add
more servers and No if you need to install more servers. The system
will restart. If you selected “No”, the system the installation program
will close. After you have installed all required servers, you must
restart the system, so that the required settings may take effect.
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Installing Older I/O Servers (Versions
below 7.0)
Note: These steps show how to complete I/O server installation if you
selected an older driver in step 6 of the previous procedure.

1. When prompted to verify setup information, click Next.

2. When prompted to review the I/O server release notes, in the next
installation dialog, you may select Yes or No.

3. Click Yes to continue the installation.

4. When the “Welcome to the system files setup program.” screen
appears, click Next.

5. When the license information screen appears, click Yes, if you agree with
the terms of the license. You must select “Yes” to complete the setup.

6. When prompted to specify an Intouch Destination directory, click Next
to keep the default.

7. You will be prompted to select the components to install. Click Next to
accept the default of all components.

8. Click Next to verify setup information and complete I/O Server
installation.

9. When prompted to add icons to the Windows Start menu, click Yes.

10. When installation is complete, click OK  to exit the setup program.

Note: Depending on your system and other drivers that you have
installed, you may have to restart the operating system.



Welcome to OpenHMI™ 1-10

Installing the Productivity Pack
Some advanced applications features will not function if the productivity
pack is not installed.

1. Insert OpenHMI CD#1 into your CD-ROM drive.

2. Click the Start button on the Taskbar, then click Run. The Run dialog
box appears.

3. Type “x:\productivity pack setup”  (x your CD-ROM
drive) in the Open text box. You must type the quotes, or the
installation program will not start. Click OK .

4. When the “Welcome to the system files setup program.” screen
appears, click Next.

5. When the license information screen appears, click Yes, if you agree
with the terms of the license. You must select “Yes” to complete the
setup.

6. Enter your name and company to complete the user information screen
and click Next.

7. Click Yes to verify the name and company.

8. When prompted to specify a directory for common components, click
Next to accept the default. The installation program will display a
progress bar as it loads some common program components.

9. If you don’t already have the Acrobat Reader installed on your system,
a sequence will begin to install the Acrobat Reader onto your system.
This reader allows you to view the online documentation that the install
program saves to hard disk in PDF format. Click Next through each
step of this sequence, then OK  when the sequence is complete.

10. When prompted to specify an Intouch Destination directory, click Next
to keep the default.

11. You will be prompted to select the components to install. Select the
components you want to install, then click Next.

Note: The SPC and SQL components are not supported by the
OpenHMI runtime workstations.

12. Click Next to verify setup information and complete installation.

13. When installation is complete, the program will recommend that you
read the release notes. Click OK .

14. At the final prompt click OK . The system will restart.
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Enable Configurator License
Before you can run the installed OpenHMI  software, you must run the
program on the Open HMI Consignment license floppy diskette (labeled,
“consign 1000 tag/100 window”) that enables the program’s software.
(Runtime licenses for OpenHMI workstations are preloaded.) If you do not
enable the license and attempt to run the software, the OpenHMI  program
displays a warning message and denies access.

Note: The configurator enables the WindowMaker software for a one-year
period from date of manufacture.

Tag Database Size: The OpenHMI  tag database supports up to 1,000 tags;
however, the number of tags supported is dependent on the license
information provided by the configurator (either 500 or 1000 tag license).
The database may be limited to less than the maximum number of tags.

1. To open Windows Explorer, click the Start button on the Taskbar, and
then select Programs and Windows Explorer.

2. Insert your Xycom Open HMI Consignment license disk into the A:
drive of either your laptop or your PC.

3. Click on 3 ½ floppy (A:) icon in Windows Explorer.

4. Double-click on Install.bat. A license utility-Lic View screen will
appear.

 
5. From the File menu, select Install License File.
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6.  Select 3 ½ Floppy (A:) from the Look in drop-down list.

7. Double-click on the license folder in the Window. You will see two
files: IO Server.lic and Wwsuite.lic.

8. Select only the Wwsuite.lic file and click Open. Information about
destination computer and domain computer will appear.

Note: If the Domain and Computer name do not appear, contact your
system administrator for the correct information.

9. Click OK .

10. If a license already exists on the PC, you will be prompted to overwrite,
append, or cancel the license. You should select Append (the default).

11. Click OK . The files have successfully loaded.

12. Close the License Viewer (licview.exe) program. You are finished.
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This Getting Started with OpenHMI guide is designed for first  time users
of OpenHMI . Its objective is to allow you, the user, to quickly familiarize
yourself with the basic functions of OpenHMI . It acts as a step by step
"workbook" in which you go through the process required to create your
first working OpenHMI  application. This tutorial will include creation of
the application, the window/screen, graphic components, animation links
and the database. For more detailed technical information refer to the
OpenHMI User's Guide.

Throughout this guide you will see checkboxes (�) followed by bold text.
These checkboxes and text indicate the development steps required to
complete this application. You can place a check mark in these boxes as
you proceed so that no steps will be omitted. This allows you to complete
the application at your leisure, taking time to read the text.

�Hint  This symbol implies that the following text is a hint, useful in
creating future applications.

If you are unfamiliar with Windows 95 or Windows NT, we suggest that
you first select Help from the Windows Start menu before you continuing
with this guide.

Creating Your First Application
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Let’s Get Started
This is a simple application that quickly runs your through all the major
steps to develop and run an HMI application. For more information on in-
depth applications, take a look at the demo applications included with your
OpenHMI software.

  To create your first application:

� In Windows 95 or Windows NT, select the OpenHMI  icon from the
Start/Programs/Wonderware Factorysuite/Intouch folder.

The following dialog box appears:

 

Note:  For complete details on this dialog box, see the InTouch
Application Manager section.

� Click the New button  to create a new application directory.

� After a welcome screen (click Next), the manager will prompt you to specify
a directory for the application’s files. Click Next to accept the default.
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� The next dialog will prompt you to enter a Name and application
description. For the name enter NewApp.

� Click Finish. NewApp will appear in the Application Manager list.

�Hint  To avoid confusion when creating new applications, use the same
application and directory name.
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Build a Window

� Highlight NewApp in the Intouch Application Manager.

� Click on the WindowMaker  button  to run the OpenHMI
development environment.

An OpenHMI  application is built as a set of related windows or screens
that are created in WindowMaker , the development environment. A
window may occupy all or only a portion of the screen as required by the
application. The number of windows that can be displayed at one time is
governed by the size of the windows in relation to the space available on the
screen. The runtime environment of OpenHMI  is called WindowViewer.
This is the environment that displays what was created in WindowMaker
and maintains communication links.

� If prompted for Network Interface Selection, click Done. The
WindowMaker will appear.
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� To create your first window, choose the File/New Window command to
open the Window Properties dialog box:

 

Note: You cannot select the Double or None Frame Styles radio button
when Title Bar  and Size Controls are checked.

� Enter Test as the Name and Download Test Screen as the Comment that
you want to appear in the title bar of the window. Click the Window Color
box to select a background color for the window. The color palette appears.
Click on the color you want to use.

All other fields/options can be left at the default values for this exercise. For
detailed information concerning these window options, refer to the
program’s online help (accessed through the help menu) or the online PDF
documentation (accessed through the shortcut on your desktop).

� Select OK when finished with the selections.

�Hint   A window's type, logic and properties can be changed whenever it is
open in WindowMaker  by invoking the Windows/Window Properties...
command.

What is a Window Type?
A "Replace" window replaces any window(s) (including popups) that it
touches when it appears. Any intersected window is automatically removed
from the screen and its associated "tags" are no longer polled.

An "Overlay"  window appears on top of currently displayed window(s)
(except pop-ups). When an overlay window is closed, the window(s) that
were hidden by it reappear. Clicking on a visible portion of a window
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beneath an overlay window will cause that window to be brought to the
foreground as the active window.

A "Popup"  window is similar to an overlay window except that it always
stays on top of all other open windows, even if another window is clicked
on. Popup windows usually require a response from the user in order to be
removed (i.e., acknowledging alarms).

�Hint   Whenever possible, use Replace type windows. Replace windows
will remove any window(s) it touches, improving performance by not
having to poll the "points" that were on the previous window(s) PLUS the
"points" on the new window being shown.

Creating the Graphic Objects
Now that you have a window on the screen, the WindowMaker  toolbox
should be visible. If you do not want the grid to show, click on the Snap to
Grid Tool   in the View toolbar. (Default location of this toolbar is the
lower left corner of the WindowMaker editor. The Snap to Grid Tool turns
the visible grid off in addition to turning off the snap function.

�Hint  The key combination, Shift+F1, will cause a question mark (?) to
appear on the cursor. Click on any menu item or tool in the toolbox for
quick, on-line help.

� To begin, select the Wizard icon  from the toolbar.
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� In the Wizard Selection dialog that appears, select Lights in the left pane
and then double-click on the Round Siren icon.

� The arrow cursor will change: . Move the cursor in the window area to
select a position for the siren.

� Click the left mouse button to place the siren.
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� Double-click on the Round Siren light. The Light Wizard dialog appears.

� To complete the Light Wizard dialog that appears, replace the default value
in the Expression field with Light, then click OK .
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� When prompted, “Define Light ‘Tagname Undefined’,” click OK  to open
the Tagname Dictionary.

� Select Close to accept the default values for the tag, Light.

�Hint  Detailed information concerning the other fields in this dialog box
may be found in the program’s online help (accessed through the help
menu) or the online PDF documentation (accessed through the shortcut on
your desktop)..

� To add the second instrument, select the Wizard icon  from the toolbar.

� In the Wizard Selection dialog that appears, select Buttons in the left pane
and then double-click on the Color Pushbutton icon.
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� Place the pushbutton, then double-click on it to open the Pushbutton
Wizard dialog.

� Enter Light in the Tagname field.

� Under Action, select the Toggle radio button.

� Check the Key equivalent box and then click Key... and select F7 as the
key equivalent.

� Click OK .

� Select Save Window from the File menu.

� When prompted to save Test, click OK .

Optional:  To verify that NewApp functions correctly, select the Runtime
menu item (in upper right corner of WindowMaker). This menu selection
opens the application in the WindowViewer. If the application is configured
correctly, you should be able to click on the pushbutton with the arrow
cursor and see the siren and button change color. To exit the
WindowViewer and return to the WindowMaker, select the Development
menu item (in the upper right corner of the WindowViewer).

� Establish Test as a home window (optional). Windows that you specify as
home windows for you application will automatically open when you start the
application. For this sample application this step is optional, but you may
want to follow these short bulleted steps to become familiar with the process.

•  In the left pane of the WindowMaker, expand the Configure item by
double clicking on the Configure icon.

•  Under the Configure item, double-click on the WindowViewer icon.
The WindowViewer properties dialog appears.
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•  Click on the Home Windows tab.

•  Click on the Test checkbox, so that a check appears.

•  Click OK .

� Select Exit from the File Menu.

You have now completed development of the test OpenHMI  application.
Next, you will need to download the application to the runtime workstation.
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Runtime Workstation Quick Start-up
Before you download applications to your runtime workstation, follow
these steps to get the system running.

Note: Do not attach a PS/2 mouse to touchscreen units. The mouse port is
not available on touchscreen units. If COM2 is not being used (by the IrDA
port or another serial device) on a Windows 95 system, you may connect a
serial mouse to the unit. COM2 will be disabled on touchscreen models
with a Windows NT operating system.

Note: To meet compliance for hazardous locations ratings, OpenHMI
workstations do not include powercords. You will need to follow the
instructions to create a power cord in your OpenHMI System Guide.

Warning:  Disconnect the powercord before making any adjustments to the
inside or outside of the computer.

Perform the following steps before downloading a developed OpenHMI
application to the workstation:

1. Attach optional equipment (a floppy drive is required to download the
sample application in this manual, refer to the System Guide for more
information):

2. Create a power cable (refer to System Guide).

3. Turn on power to the unit. The system will boot up.

4. If you have a unit with an STN display you will need to adjust the
display contrast. (TFT displays don’t require adjustment; the unit
automatically adjusts the contrast.) On units with keypads, press and
hold the F/A key, then press the left or right cursor keys to increase or
decrease contrast. On units without keypads use the controls located
below the flat panel display.

5. Before the Windows operating system will start, the Windows Setup
Wizard appears. The first dialog prompts you to enter your Name and
Company.

6. When the license agreement appears, click Accept to agree to the terms
and continue the load and installation. (If select Don’t Accept, the
operating system will shut down.

7. When prompted for your Product ID, you must locate the Windows
operating system backup kit (shipped with the unit) and type in the
Product ID on the package.
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8. Click Next.

9. Answer Yes to all prompts about keeping newer files.

10. Click FINISH to complete the load and installation.

11. Enter your Windows username and password:

Note: You can omit the password at this time and assign it later: click OK .

12. New screens will appear:
•  New Hardware Found

•  Copying Files

•  Version Conflicts (click Yes when prompted with version conflict
dialog windows)

13. Date and Time properties appear. To change the time zone, click on the
drop down box and then choose the appropriate zone.

14. Add the Printer Wizard:
•  Ask your IS Department and follow instructions or consult your printer

manual.

•  Click Next. If no printer is attached, click CANCEL .

15. The Welcome to windows screen appears. Either take the optional tour
or click CLOSE.
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Transferring the Application to the Workstation
Depending on your operating system and the networking options available
to you, you can transfer your application through many different media.
This sample application fits easily on a floppy diskette. Larger applications
may require a compression program or alternate download method. For any
application that you create, you should refer to the downloading instructions
in chapter 3 and determine the best method for your application.
To load your test application, NewApp, onto the workstation, this section
will cover a transfer with floppy diskette. First, you will copy the
application from your development PC to a diskette, then you transfer the
application to the workstation.

Copy Application from Development PC
� Insert a blank, formatted diskette into the development PC’s floppy drive.

� Click the Start button, then select the Windows Explorer icon from the
Programs folder.

� Under the C-drive (in the left pane of the Windows Explorer), expand the
Program Files folder, then expand the Factory Suite folder, then select the
InTouch folder.

� Select the folder NewApp (in the right pane of the Windows Explorer) and
drag it to the A drive icon (in the left pane of the Windows Explorer).

� After the copying finishes, remove the diskette and label it, NewApp.

Transfer Application to Runtime Workstation
� Insert the diskette (with NewApp copied onto it) into the runtime

workstation’s floppy drive into the runtime workstation.

� Click the Start button, then select the Windows Explorer icon from the
Programs folder.

� Under the C-drive (in the left pane of the Windows Explorer), expand the
Program Files folder, then expand the Factory Suite folder.

� Select the A-drive icon.

� Select the folder NewApp (in the right pane of the Windows Explorer) and
drag it to the InTouch folder (under c:\program files\factory suite, in the
left pane of the Windows Explorer).

� After the copying finishes, you may close or minimize the Windows
Explorer to return to the desktop.
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Launch the Test Application on Runtime Workstation
� Double-click OpenHMI shortcut on the Windows desktop.

� On the Tools menu, click Find Applications. The Starting directory for
search dialog box appears. Make sure that the Look in drop-down list
specifies the c:\Program Files\FactorySuite\Intouch directory.

� Select the NewApp folder in the main window and click OK .

Note: Although other icons will appear on the main toolbar, the
WindowMaker is not licensed to run on an OpenHMI workstation.

� Click on the WindowViewer  icon.

� You may be prompted to convert screen size. You should select Yes to
answer this prompt.

� If you are launching the application on a Windows 95 workstation, a node
screen appears. Click Cancel.

� When the Windows to Show dialog appears, select the Test check box and
click OK . (This dialog will not appear if you have specified Test as a Home
window.)

� The WindowViewer appears and displays the Test window. The pushbutton
and siren will toggle between two colors when pressed through touchscreen
input or an F7 keypress.

� Select Exit from the File menu to exit the application.
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You've created a simple OpenHMI  application that involves only the most
basic elements of the product. You should be aware that there is far more to
OpenHMI . The sample application is intended simply to give you an
introduction to OpenHMI .

Now that you've had a taste of what you can do with it, you may want to
explore its other more advanced capabilities:

• Alarm and Event Monitoring
• Security
• Real-time Trending
• Logic Script Implementation
• Networking
• Recipe Management
• Application Bullet proofing
• Intelligent Wizard Objects, and more...

In addition to these OpenHMI  application development features, Xycom
Automation also offers:

• A complete line of I/O Servers that provide an I/O interface to all
major manufacturers' PLCs and other control devices.

• Network interfaces to communicate with other hardware platforms.
Before you start to develop more complex applications, you should read this
chapter for a fuller overview of the application manager and the procedures
to download applications to a workstation. We also urge you to read
through the OpenHMI  User's Guide, which is installed with your program
as a PDF file,  to investigate all of the program’s capabilities. For additional
application samples, you can preview any of the demo applications
(preloaded on your runtime workstation) by selecting and opening them in
the application manager.

Creating and Maintaining More Complex
Applications
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InTouch Application Manager
You will use the InTouch Application Manager to create new applications,
open existing applications in either WindowMaker or WindowViewer,
delete applications, and run the OpenHMI DBDump and DBLoad Tagname
Dictionary utility programs.

� To run the InTouch Application Manager:

1. Start the OpenHMI program (INTOUCH.EXE). The InTouch
Application Manager dialog box appears:

 

� When you select an application in the list, it's name and it's description
will appear in the box at the bottom of the screen. If you right-click the
description box, a menu appears displaying the commands that you can
apply to the selected text.

 You can also execute several of the InTouch Application Manager's
menu commands from the menu that appears when you click the right
mouse button as you select an application. For example:
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2. To rename an application's icon, right-click the application in the list,
and then click Rename. Type the new name and press ENTER.

3. To delete an application's icon, right-click the application in the list,
and then click Delete. A message box will appear asking you to
confirm the deletion. Click Yes to delete the application from the
window or click No to cancel the deletion.

� If you delete an application from the list, it does not delete your
files or directory. If you need to display it later, on the Tools menu,
click Find Applications. The Starting directory for search
dialog box appears:

 

Locate the directory in which you want to search for applications,
and then click OK . The InTouch Application Manager will
reappear displaying icons for all applications that were found in the
selected directory.

� If you right-click in the window, a menu will appear
displaying the commands that you can apply to a selected
item.

�   To create a new application:

1. On the File menu, click New, or click the New tool in the toolbar. The
Create New Application wizard will appear.
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2. Click Next. A second Create New Application wizard will appear.

� By default, the system will display the path to your OpenHMI
directory followed by "NewApp."

3. In the input box, type the path to the directory in which you want your
application to be created or click Browse to locate the directory.

4. Click Next.

� If the directory you specify does not exist, a message dialog box
will appear asking if you want to create it. Click OK . A third
Create New Application wizard dialog box will appear.

5. In the Name box, type a unique name for the new application's icon
that appears when the application is listed in the InTouch Application
Manager window.

Note: Filename and Application name can be different, but we recommend
that you make them the same to simplify organization.

6. In the Description box, type a description of the application.

� The description is optional. However, if you do type a description,
it can be a total of 255 characters.

7. Click Finish. The OpenHMI - Application Manager  will reappear
displaying an icon with the name you specified for the new application.
For example:

 
8. To open an application, click the right mouse button as you select it,

and then click the name of the program you want to use for the
application in the File menu, or select the application in the list, and
then click the WindowMaker tool in the toolbar. (WindowViewer
cannot be executed for a new application.)
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To quickly open the application, double-click it's icon or select it, and then
press ENTER.

The Application Manager's Tools
By default when OpenHMI is initially run, the Application Manager's
toolbar and status bar are displayed.

� To hide the toolbar:

On the View menu, select Toolbar. To show it again, repeat this step.

� To hide the status bar:

On the View menu select Status Bar. To show it again, repeat this step.

The following briefly describes each of the Application Manager's toolbar
buttons:

Button Description

Executes the New command on the File menu  to create
a new application.

Executes the WindowMaker  command on the File
menu to open the selected application in
WindowMaker.

� To quickly open an application in WindowMaker,
double-click it's icon or select it, and then press ENTER.)

Executes the WindowViewer command on the File
menu to open the selected application in
WindowViewer.

Executes the DBLoad command on the File menu to
run the DBLoad utility used to load a Tagname
Dictionary input file.

Executes the DBDump command on the File menu to
run the DBDump utility program used to extract an
application's Tagname Dictionary.

Executes the Large Icons command on the View menu
to display large icons for the listed applications.
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Executes the Small Icons command on the View menu
to display small icons for the listed applications.

Executes the List  command on the View menu to
change the dialog box to the list view mode. For
example:

 
Executes the Details command on the View menu to
change the dialog box to the details view mode. For
example:

 

� Double-clicking the right vertical separation bar of a column header
will auto-size the column.
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 If you right-click any of the column headers, or click a blank area of the
window, or click a detail (other than the application name) the
following menu appears:

 

 If you point to View, the following submenu appears:

 

 These commands are also found on the View menu. They control the
display list in the InTouch Application Manager.

Opens the Node Configuration dialog box that
you will use to set Dynamic Resolution Conversion
(DRC).

Note: Other features and menu selections are not
operational during the OpenHMI’s WindowViewer
runtime.
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Note  When an application is selected in the Application Manager display
list, selecting the Properties command on the File menu will cause the
Properties dialog box for that application to appear:
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Downloading the Application
In a real world application, you would need to download your application to
a workstation before you could start communicating with I/O. As discussed
in the introduction of this guide, an  Xycom Automation HMI application
consists of two components: a development system (the WindowMaker
configurator software installed on any PC) and the runtime environment
(the WindowView runtime software on an OpenHMI  workstation). When
you complete your application, you can download the application through
several different media.

After you have downloaded an application, you can start it and begin I/O
communications by running the WindowView program on the workstation.

Floppy Diskette
� Log onto your development system.

� From the Start menu’s Program folder, click Windows Explorer.

� Select the project directory that is to be transferred (usually under
c:\program files\FactorySuite\Intouch).

����������	

�

�������� ��	���
�����	�	���

��������
�������	���������

����	� ����� ��
����� �����	����

����� ��������

���� ����



Creating and Maintaining More Complex Applications 3-10

� Copy the entire folder to another directory location and rename the folder.
We recommend using YourAppname_Backup as a naming convention.

� In the backup folder delete the files with the following extensions:

• .wbk

• .wvw

• .avl

� Compress the remaining files with a compression utility, such as WinZip®,
and copy to a floppy diskette.

� Log onto your runtime system.

� Extract the compressed files to a file folder with the original project name.

Note: Don’t plug in the floppy drive while the diskette is in the drive. You
may corrupt the data on the diskette.

Peer-to-Peer Direct Ethernet Connection
To download the application through a direct network connection, you will
need an install and configure an Ethernet card in the development system
that connects to the runtime workstation’s built-in Ethernet.

Configure Card and Connection
Follow these procedures to configure the Ethernet card on the development
system and configure the network communications on both systems.

The Connecting Cable
Use only four of the eight pins. Pins 1 and 2 must be a pair, and pins 3 and 6
must be a pair. Wire the cable as follows:
Function Pin# Pin# Function
TX+ 1 <————> 3 RX+
TX- 2 <————> 6 RX-
RX+ 3 <————> 1 TX+
RX- 6 <————> 2 TX-

Windows 95 Systems

� Open the Control Panel and double-click on the Network icon.

� In the Network dialog select the Configuration  tab.
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� Under the Configuration  tab, click on the Add button

� Development PCs require a configured adapter. Follow these steps if the
Ethernet adapter is not configured on your development PC:

1. Select Adapter and click on the Add button.

2. From the list box select the driver for your type of adapter or click on
Have Disk if you have unlisted third party drivers. (You will need to
specify a directory or drive to select unlisted third party drivers from.)

3. Click OK .

4. Select Protocol and click on the Add button.

5. From the list box select Microsoft from the Manufacturers list box and
Net BEUI from the Network Protocols list box.

6. Click OK .

� Select Client and click on the Add button.

� From the list box select Microsoft from the Manufacturers list box and
Client for Microsoft Networks  from the Network Clients list box.

� Click OK .

� Under the Configuration  tab, click on the Add button

� Click on the File and Print Sharing button.

� Check the I want to be able to give others access to my files item.

� Click OK .

� Select the Identification  tab.

� Enter the computer name (different name for each computer) and
workgroup (enter same workgroup name for each computer).

� Select the Access Control tab.

� Select the Share-level Access Control radio button.

� Click on the Network dialog’s OK  button.

� When prompted to restart the computer, select Yes.
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Windows NT Systems

� Open the Control Panel and double-click on the Network icon.

� In the Network dialog select the Configuration  tab.

� Under the Configuration  tab, click on the Add button

� Development PCs require a configured adapter. Follow these steps if the
Ethernet adapter is not configured on your development PC:

1. Select Adapter and click on the Add button.

2. From the list box select the driver for your type of adapter or click on
Have Disk if you have unlisted third party drivers. (You will need to
specify a directory or drive to select unlisted third party drivers from.)

3. Click OK .

4. Under the Configuration  tab, click on the Add button

5. Select Protocol and click on the Add button.

6. From the list box select Microsoft from the Manufacturers list box and
Net BEUI from the Network Protocols list box.

7. Click OK .

� Under the Configuration  tab, click on the Add button

� Select the Identification  tab.

� Enter the computer name (different name for each computer) and
workgroup (enter same workgroup name for each computer).

� Click on the Network dialog’s OK  button.

� •  When prompted to restart the computer, select Yes.

Transfer Application Files
To transfer your files you will first need to set up file sharing on your
runtime PC. You will than access the shared folder from the development
system and transfer the files to the runtime system.

File Sharing on a Windows 95 Runtime Workstation

� Log onto your runtime system.

� Open Windows Explorer.
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� Find and select the folder that you want to copy your OpenHMI application
files into.

� Select File/Properties.

� Select the Sharing tab, then select the Shared As radio button.

� Enter a share name.

� Set the access type to Full .

Note: After you set the sharing properties for the project folder, you can
transfer files when needed to update the workstation with application
changes.

� Click OK .

File Sharing on a Windows NT Runtime Workstation

� Log onto the runtime system as an administrator.

� From the Start menu open the User Manager (Programs/Administrative
Tools (Common)/User Manager).

� Create a new user and enter the username and password of the development
system that the application files will be transferred from.

� Unless your application requirements demand otherwise, select the
Password Never Expires radio button.

� Click OK  to save the new user.

� Close the User Manager.

� Open Windows Explorer.

� Find and select the folder that you want to copy your OpenHMI application
files into.

� Select File/Properties.

� Select the Sharing tab, then select the Shared As radio button.

� Click on the Permissions button.
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� Access to the shared directory defaults to full access for everyone.  If more
security is desired, click on the Remove button to remove the access.

� To add the new (development system) user from the Sharing tab:

1. Click on the Add button, then click on the Show Users button.

2. Select the new user from the list box.

3. Set the access type to Full .

Note: After you set the given permissions for the project folder, you can
transfer files when needed to update the workstation with application
changes.

Transfer Files to Shared Runtime Workstation Folder

� To transfer the files between two Windows NT systems, two Windows 95
systems, or from a Windows NT development system to a Windows 95
runtime system:

1. Log onto the runtime workstation.

2. Open the Windows Explorer  and locate the runtime workstations name
and shared folder under the Network Neighborhood icon.

3. Drag the development system’s application files into the shared runtime
folder.

� To transfer the files from a Windows 95 development system to a Windows
NT runtime system:

1. Log onto the development workstation.

2. Open the Windows Explorer  and select Find Computer from the
Tools menu.

3. In the Find Computer dialog enter the name of the runtime workstation.

4. Click Find Now.

5. Double-click on the computer icon that appears.

6. Drag the development system’s application files into the shared runtime
folder.

Existing Ethernet Network Connection
You will need installed Ethernet cards in the development system and the
runtime workstation that are physically connected to the Ethernet network.
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Configuring your Ethernet Connection
These steps are assuming that your network adapter on your runtime
workstation is functioning properly and you can go out on the network.

Windows 95 Systems

� Open the Control Panel and double-click on the Network icon.

� In the Network dialog select the Configuration  tab.

� Under the Configuration  tab, click on the Add button

� Select Client and click on the Add button.

� From the list box select Microsoft from the Manufacturers list box and
Client for Microsoft Networks  from the Network Clients list box.

� Click OK .

� Click on the File and Print Sharing button.

� Verify that both check boxes are checked to share folders.

� Click OK .

� Select the Identification  tab.

� Enter the computer name (different name for each computer) and
workgroup (enter same workgroup name for development PC and runtime
workstation).

� Select the Access Control tab.

� Select the Share-level Access Control radio button.

� Click on the Network dialog’s OK  button.

� When prompted to restart the computer, select Yes.

Windows NT Systems

� Open the Control Panel and double-click on the Network icon.

� In the Network dialog select the Configuration  tab.



Creating and Maintaining More Complex Applications 3-16

� Under the Configuration  tab, click on the Add button

� Select Protocol and click on the Add button.

� From the list box select Microsoft from the Manufacturers list box and Net
BEUI  from the Network Protocols list box.

� Click OK .

� Select the Identification  tab.

� Enter the computer name (different name for each computer) and
workgroup (enter same workgroup name for development PC and runtime
workstation).

� Click on the Network dialog’s OK  button.

� •  When prompted to restart the computer, select Yes.

Transfer Application Files
To transfer your files you will first need to set up file sharing on your
runtime PC. You will than access the shared folder from the development
system and transfer the files to the runtime system.

File Sharing on a Windows 95 Runtime Workstation

� Log onto your runtime system.

� Open Windows Explorer.

� Find and select the folder that you want to copy your OpenHMI application
files into.

� Select File/Properties.

� Select the Sharing tab, then select the Shared As radio button.

� Enter a share name.

� Set the access type to Full .

Note: After you set the sharing properties for the project folder, you can
transfer files when needed to update the workstation with application changes.

� Click OK .
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File Sharing on a Windows NT Runtime Workstation

� Log onto the runtime system as an administrator.

� From the Start menu open the User Manager (Programs/Administrative
Tools (Common)/User Manager).

� Create a new user and enter the username and password of the development
system that the application files will be transferred from.

� Unless your application requirements demand otherwise, select the
Password Never Expires radio button.

� Click OK  to save the new user.

� Close the User Manager.

� Open Windows Explorer.

� Find and select the folder that you want to copy your OpenHMI application
files into.

� Select File/Properties.

� Select the Sharing tab, then select the Shared As radio button.

� Click on the Permissions button.

� Access to the shared directory defaults to full access for everyone.  If more
security is desired, click on the Remove button to remove the access.

� To add the new (development system) user from the Sharing tab:

1. Click on the Add button, then click on the Show Users button.

2. Select the new user from the list box.

3. Set the access type to Full .

Note: After you set the given permissions for the project folder, you can
transfer files when needed to update the workstation with application changes.

Transfer Files to Shared Runtime Workstation Folder

� To transfer the files between two Windows NT systems, two Windows 95
systems, or from a Windows NT development system to a Windows 95
runtime system:
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1. Log onto the runtime workstation.

2. Open the Windows Explorer and locate the runtime computer and then
the shared folder under the Network Neighborhood icon.

3. Drag the development system’s application files into the shared runtime
folder.

� To transfer the files from a Windows 95 development system to a Windows
NT runtime system:

1. Log onto the development workstation.

2. Open the Windows Explorer  and select Find Computer from the
Tools menu.

3. In the Find Computer dialog enter the name of the runtime workstation.

4. Click Find Now.

5. Double-click on the computer icon that appears.

6. Drag the development system’s application files into the shared runtime
folder.

Serial Connection (For Windows 95)
� Plug serial cable from development system to runtime workstation’s COM1

RS-232 port.

� Plug keyboard into runtime workstations with touchscreen.

� Power up both PCs.

� For both PCs add the File and Print Sharing service.

1. Log onto the PC.

2. Open the Control Panel and double-click on the Network icon.

3. In the Network dialog select the Configuration  tab.

4. Under the Configuration  tab, click on the Add button

5. Select Services and click on the Add button.

6. From the list box select Microsoft from the Manufacturers list box and
Print and File Sharing for Microsoft Networks from the Services list
box.

7. Click OK .
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Transfer Application Files
You can initiate file transfers from the development PC/host (download) or
the runtime workstation/guest (upload).

� Log onto your development system.

� Open Windows Explorer.

� Select the project directory that is to be transferred (usually under
c:\program files\ FactorySuite\Intouch).

� Select File/Properties.

� Select the Sharing tab, then select the Shared As radio button.

� Enter a share name.

� Set the access type:

• To Read-only if you plan to download files from the runtime
workstation.

• To Full  if you plan to upload files from the development system.

Note: After you set the sharing properties for the project folder, you can
transfer files when needed to update the workstation with application
changes.

� Click OK .

� Log onto the runtime workstation to set it up as the guest computer.

� From the Start menu, select Programs/Accessories/Direct Cable
Connection.

� Click on the Change button.

� Select Guest, then click on Next.

� Return to the development PC to set it up as the host computer.

� From the Start menu, select Programs/Accessories/Direct Cable
Connection.

� Click on the Change button.
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� Select Host, then click on Next.

� Select Serial Cable on COM1, then click on Next.

� Click on Finish. Leave the User password protection box unchecked.

� Return to the runtime workstation and click the OK  button on the
timeout prompt.

� The workstation will prompt you for the host computer name. Refer to the
development PC to determine the computer name you should enter.
(Double-click on the Network icon in the Control Panel, then select the
Identification  tab.)

� Click on the OK  button.

� To transfer the files from one computer to another:

1. Log onto the development system or  runtime workstation.

2. Open the Windows Explorer and locate the shared folder under the
Network Neighborhood icon.

3. Select the development system’s project folder and drag it into the
workstation’s c:\program files\FactorySuite\Intouch  folder.

IrDA Port (For Windows 95)
Configure the IrDA Port
If you choose to transfer files through the IrDA port you must first
configure the port for the development PC and runtime workstation.

Note: These steps cover IrDA port configuration for the runtime
workstation. If the development PC’s IrDA port is not already configured,
you should refer to the PC’s documentation to configure the port.

� Press the F2 key while the system boots up to enter the CMOS setup of your
OpenHMI workstation. (If you have trouble, please refer to the system
manual.)

� Use the right arrow to select the Advanced menu.

� Press Enter to select the first item, Integrated Peripherals.

� Use the down arrow to select UART 2 Mode.
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� Use the + key to change the UART2 Mode field to IrDA .

� Press the Esc key twice to exit the CMOS submenus.

� Press Enter to save changes, then again to confirm the changes and exit.

� Allow system to boot to Windows 95.

� After Windows 95 has started, open the Control Panel and double-click on
the Add New Hardware icon.

� To complete the Add New Hardware wizard:

1. Click on Next.

2. When prompted if you want Windows to search for new hardware
select the No radio button, then click on the Next button.

3. Click on Next.

4. Select Infrared  from the list box of Hardware Types, then click on
Next.

5. Click on Next.

6. Click on Next to accept the defaults of Standard Infrared Devices and
Built in Infrared Port  on laptop or desktop. (If needed change dialog
fields to match these default values.)

7. From the Available Ports list box, select the port that this infrared
device is physically connected to (COM2), then click on Next.

8. Click on Next to accept the default ports COM4 and LPT3. (If needed
change dialog fields to match these default values.) After this prompt,
the wizard will begin to install and configure the necessary driver and
other files. It may prompt you to insert your Windows 95 CD, so that it
can copy files to the hard drive.

9. Select Finish.

� Double-click on the Infrared  icon in the Control Panel. (If the icon does
not appear in the window, press F5 to refresh the view.)

� Select the Options tab.

� Verify that Enable infrared communication on is set to COM2 and
“Providing application support on COM4 and LPT3” appears.

� Click on the OK  button to run the driver.
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File and Print Sharing
Before you can transfer application files through the configured IrDA port,
you will need to add the File and Print Sharing service to the PC and
runtime workstation.

� For both PCs add the File and Print Sharing service.

� Log onto the PC.

� Open the Control Panel and double-click on the Network icon.

� In the Network dialog select the Configuration  tab.

� Under the Configuration  tab, click on the Add button

� Select Services and click on the Add button.

� From the list box select Microsoft from the Manufacturers list box and
Print and File Sharing for Microsoft Networks from the Services list
box.

� Click OK . You may need to restart your system.

Transfer Application Files
You can initiate file transfers from the development PC/host (download) or
the runtime workstation/guest (upload).

� Log onto your development system.

� Open Windows Explorer.

� Select the project directory that is to be transferred (usually under
c:\program files\ FactorySuite\Intouch).

� Select File/Properties.

� Select the Sharing tab, then select the Shared As radio button.

� Enter a share name.

� Set the access type:

• To Read-only if you plan to download files from the runtime
workstation.
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• To Full  if you plan to upload files from the development system.

Note: After you set the sharing properties for the project folder, you can
transfer files when needed to update the workstation with application
changes.

� Click OK .

� Log onto the runtime workstation to set it up as the guest computer.

� From the Start menu, select Programs/Accessories/Direct Cable
Connection.

� Click on the Change button.

� Select Guest, then click on Next.

� Select Serial Cable on COM4, then click on Next.

� Click on Finish. The  will now try to connect using the IrDA port. It may
time out and post a message, “Wait here until the ‘other’ computer is ready
to communicate.”

� Return to the development PC to set it up as the host computer.

� From the Start menu, select Programs/Accessories/Direct Cable
Connection.

� Click on the Change button.

� Select Host, then click on Next.

� Select Serial Cable on COM4, then click on Next.

� Click on Finish. They  will now try to connect using the IrDA port. Leave
the User password protection box unchecked.

� Return to the runtime workstation and click the OK  button on the timeout
prompt.

Note: Both PCs should now be able to see each other, if in range. The IrDA
icon will appear on the Windows taskbar.
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� The workstation will prompt you for the host computer name. Refer to the
development PC to determine the computer name you should enter.
(Double-click on the Network icon in the Control Panel, then select the
Identification  tab.)

� Click on the OK  button.

� To transfer the files from one computer to another:

1. Log onto the development system or  runtime workstation.

2. Open the Windows Explorer and locate the shared folder under the
Network Neighborhood icon.

3. Select the development system’s project folder and drag it into the
workstation’s c:\program files\FactorySuite\Intouch  folder.
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Automatic Application Startup
You can automate some or all of the login and application startup process
on an OpenHMI workstation.

Set Automatic Login
On a Windows 95 workstation you can bypass the login prompt that appears
after the system boots up. We recommend the Tweek UI utility, which is
preloaded on a Windows 95 OpenHMI workstation.

Note for Windows NT Workstation: Automatic login cannot be
configured on a Windows NT workstation. When the workstation is
restarted, an administrator must login to the workstation before it will start
the OpenHMI application.

� From the desktop Start menu, select Settings then Control Panel, and
choose the Start Menu Programs tab.

� Double-click on the  icon.
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� Select the Network tab.

� Check the Log on automatically at startup checkbox.

� Enter your logon user name and password in the text boxes. If you have a
password, you must enter it.

� Click OK .

� From the desktop Start menu, select Shutdown.

� In the Shut Down Windows dialog that appears, select the Restart
Windows radio button and click OK .



Creating and Maintaining More Complex Applications 3-27

� After the system restarts, you may be prompted with a welcome screen. If it
appears, you should uncheck the Show this welcome screen next time
checkbox, so the welcome screen will not appear when the system restarts
and interfere with automatic OpenHMI application startup.

Set Application Startup
Note: The default setting for the OpenHMI workstation is to boot into the
Windows desktop.

� From the desktop Start menu, select Settings then Control Panel, and
choose the Start Menu Programs tab.

� Click Add to view the Create Shortcut window
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� Load your I/O Server using the browse button on this dialog.  Locate the
I/O Server (EXE) which should be located in a separate folder C:\Servers
(pre version 7.0 servers) and C:\Program Files\FactorySuite\IOServer (for
version 7.0 and above)

� Select the I/O Server Program file then select Open.  Click Next.

� Click Add again to view the Create Shortcut window

� Type “C:\Program Files\FactorySuite\InTouch\view.exe” “C:\
Program Files\FactorySuite\InTouch\ your application folder

name”  into the command line and select Next. You must type the quotes.
Also, note that there is a space between the items in quotes. For example:
“C:\Program Files\FactorySuite\InTouch\view.exe” “C:\

Program Files\FactorySuite\InTouch\demoapp1\640\” .

� In the select program folder window select the startup folder then click
Next.

� The default name for the icon will be view.exe.  You may select another
name for the shortcut if you would like.  Select Finish when complete.
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� Click OK  in the Taskbar Properties Window.
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Special OpenHMI Features
OpenHMI software includes the following features:

� Application Explorer
 The hierarchical Application Explorer provides you with improved

navigation capabilities. For example, it displays the names of all the
windows you have created, and when you double-click a window
name, the window opens. When you right-click a window name, a
menu appears displaying the various commands that you can execute to
open the window, save the window, open the window's QuickScripts,
its properties dialog box, and so on.

� Applications Run on Windows NT or 95 Operating System
 The applications you create on the Windows 95 or the Windows NT

operating systems are interchangeable. They can run on either
operating system without requiring conversion.

� ActiveX Container
 OpenHMI is an ActiveX container. It allows you to install any third-party

ActiveX control and use it in any application window. For easy access to
your installed ActiveX controls, you can add them to your
WindowMaker Wizards/ActiveX Toolbar. By using ActiveX controls,
you can handle control events, control methods, and control properties all
from QuickScripts. You can also associate the ActiveX control properties
directly to tagnames.

� Tag Browser
 The Tag Browser allows you to select tagnames and tagname .fields

from any tagname source that supports the OpenHMI Tagname
Dictionary interface. It is your primary tool for editing your Tagname
Dictionary.

� Tagname Cross Referencing
 The Tagname Cross Referencing utility allows you to determine in what

window or QuickScript that a specific tagname is used. For convenience,
the Tagname Cross Reference utility can remain open in WindowMaker
while you perform other tasks. It also allows you to view any
QuickScript where a tagname is found.

� Local Variables
 OpenHMI QuickScripts support the use of local variables to store

temporary results and create complex calculations with intermediate
scripting values. By using local variables in QuickScripts, you do not
decrease your licensed tagname count.
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� WindowViewer as an NT Service
 Beginning with OpenHMI 7.0, WindowViewer can be run as an NT

service. This provides NT service capabilities for key OpenHMI
components such as providing alarms and I/O data. The service
capabilities allow continuous operation of WindowViewer through
operating system log ons and log offs such as, operator shift changes.
Another functionality is automatic start up of WindowViewer
following power failure or when the machine is turned off and on. This
provides unmanned station startup of WindowViewer without
compromising NT operating system security.

� Dynamic Resolution Conversion
You can now develop applications in one screen resolution and run
them at another, without affecting the original application. The
applications can also be run at a user-defined resolution, instead of the
display resolution.

� Other OpenHMI features and benefits include:

− Real-time application process viewing.

− Connectivity with many different I/O Servers.

− SuiteLink protocol. SuiteLink allows application commands
(reads, writes and updates) and their associated data to be passed
between client applications and server applications.

− Easily networked with NetDDE.

− Standard Windows 95/NT GUI format featured.

− Right-mouse click support throughout WindowMaker for quick
access to frequently used commands.

− Floating and docking toolbars

− Customizable color palette that provides 16.7 million color
support. (The color support is limited only by your video card
capability.)

− Windows 95 and Windows NT operating systems long filename
support.
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Reaching Technical Support
Xycom Automation Technical Support offers a variety of support options
to answer any questions on Xycom Automation products and their
implementation.

In the USA (located in Saline, MI) (734) 429-4971

In Canada (located in Oakville, Ontario) (905) 825-0281

In Europe (located in Northampton, England)44-1604-790-767

In Italy (located in Turin, Italy) 39-011-3582-735

Refer to the relevant chapter(s) in your OpenHMI  documentation for a
possible solution to any problem you may have with your OpenHMI
system. If you find it necessary to contact OpenHMI  Technical Support for
assistance, please have the following information at your fingertips:

1. Software serial number and workstation model number.
2. The version of OpenHMI  you are running.
3. The type and version of the operating system (i.e. Microsoft Windows

NT version 4.0).
4. Exact wording of system error messages encountered.
5. Any relevant output listing from the Wonderware Logger, the

Microsoft Diagnostic utility (MSD), or other diagnostic applications.
6. Details of attempts made to rectify the problem(s) and results.
7. The log number assigned from Xycom Automation Technical Support

if this is an on going problem.
8. And, if known, the name of the Technical Support Engineer with whom

you last spoke.

Internet Access
Xycom Automation provides both World Wide Web and e-mail access via
the Internet. To access the Xycom Automation Home Page, use
http://www.xycom.com. This page contains the newest product datasheets,
OpenHMI  references by industrial sector, and application notes.

E-mail
To reach Xycom Automation Technical Support via E-Mail:
Saline, MI support@xycom.com
Europe support@xycom-europe.co.uk
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FAX
You can fax your questions to Xycom Automation Technical Support at:
Saline, MI (734) 429-1010
Europe 44-1604-790-722

FAX-On-Demand System
You can request application notes and datasheets for a number of our
products.

FAX-On-Demand (734) 429-4971 Ext. 455


